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Trik Seputar Komputer  

Mengaktifkan Registry Editor 

Mungkin computer Anda pernah terjangkit virus brontok. Salah satu aktivitasnya adalah 
men-disable registry, sehingga registry editor tidak bisa dibuka. 

1. Untuk mengaktifkannya sangat mudah. Bersihkan terlebih dahulu virus dari 
computer, lalu ketik perintah berikut di notepad. 

 

2. Simpan dengan akstensi .vbs (contoh kali ini, saya simpan dengan nama 
aktifkan_registry.vbs). 

 

3. Jika berhasil, jalankan file tersebut. 

 

4. Klik Yes, jika ingin mengaktifkan kembali registry editor. 

 



Membersihkan Program yang Telah diUninstal 

Setelah uninstall sebuah program, tidak otomatis semua file yang ikut bersamanya saat 
diinstal juga terhapus. Ada sebuah utility gratis yang bisa digunakan untuk membersihkan 
file bawaan dari sebuah program yang telah diuninstal. 

Aplikasi ini juga bisa memerbaiki, memelihara, melindungi computer, bahkan 
maningkatkan kinerja computer. 

Untuk mendapatkannya, bisa didownload di sini. 

Setelah selesai didownload, jalankan aplikasi tersebut. 

1. Klik Scan for issues. 

 

2. Proses scanning akan berjalan. Tunggu sampai proses scan berakhir. 

 

3. Setelah proses scanning selesai, akan terlihat jumlah masalah pada masing-masing 
kategori. Klik repair problem untuk membersihkan semua masalah tersebut. 



 

 



Menyembunyikan File 

Jika Anda memiliki folder yang sangat rahasia, sebaiknya folder tersebut disembunyikan 
(hidden).  Ada satu cara supaya folder tersebut disembunyikan. Meskipun mengaktifkan 
show hidden file, tetap tidak akan terlihat. 

Caranya sebagai berikut: 

1. Tekan Windows + R lalu ketik cmd. 

 

2. Enter. Akan tampil jendela command prompt. 

 

3. Masuk ke folder yang akan di hidden. Pada contoh kali ini, saya akan 
menyembunyikan folder foto yang berada di D:/ rahasia. Ketik D: lalu enter. 

 

4. Ketik cd rahasia lalu enter. 



 

5. Ketik attrib +s +h foto. 

 

Kini, folder tersebut hilang. 

 



Membuat Komik dari Album Foto 

Mengabadikan sebuah momen dalam tulisan memang sudah biasa. Bagaimana kalau 
mengabadikannya dalam bentuk cerita bergambar? Pasti sangat luar biasa. 

Mungkin, hampir setiap orang mengabadikan sebuah momen dalam bentuk foto. Namun, 
sangat disayangkan, foto-foto tersebut biasanya hanya tersimpan di computer begitu saja. 
Meskipun bisa dicetak, tetap saja kurang begitu menakjubkan.  

Ada sebuah aplikasi untuk menggabungkan beberapa gambar/foto yang disusun seperti 
komik, sehingga semua gambar/foto yang kita miliki bisa disusun menjadi sebuah cerita 
bergambar. Menggunakannya pun sangat mudah, cukup drag-and-drop gambar beserta 
text ke dalam template yang disediakan. 

Jika ingin mencobanya, silakan download aplikasinya di sini (trial 30 hari). 

1. Setelah didownload dan diinstal dalam computer, buka aplikasi tersebut. 

 

2. Setelah selesai mengatur gambar dan text, klik File > Export > Export to image(s). 

 



3. Simpan file tersebut dalam bentuk jpg atau png. Jika ingin disimpan di internet, pilih 
resolusi 72 dpi. Jika ingin dicetak, pilih resolusi yang paling tinggi. 

 

4. Setelah disimpan, gambar siap dipajang di rumah maupun internet. 

 



Mengganti Tampilan Bootscreen Windows XP 

Bosan dengan bootscreen bawaan dari windows XP? Saatnya kita ubah sesuai keinginan 
kita. Ada salah satu utilty dari TuneUp Utilities yang bisa digunakan untuk mengubah 
boot screen maupun welcome screen.  

Caranya sangat mudah: 

1. Buka TuneUp Utilities. Klik TuneUp Styler 2. 

 

2. Untuk mengubah boot screen, klik Change the Windows XP boot screen.  

 

3. Klik New Screen. 



 

4. Pilih gambar yang diinginkan. 

 

5. Jika ingin mengatur lebih lanjut, atur pada bagian 2 dan 3. Jika tidak ingin mengatur 
apapun, bisa langsung ke point 4, klik Save boot screen. Beri nama boot screen 
tersebut. 

 



6. Klik boot screen buatan kita, lalu klik Instal Boot Screen. 

 

7. Restart computer. Tampilan boot screen akan seperti gambar berikut. 

 

Selamat mencoba (trial 30 hari). 

 

 



Membuat Daftar Isi dan Daftar Gambar Otomatis 

Meskipun sering dilakukan, masih banyak yang membuat daftar isi dan daftar gambar 
secara manual. Padahal, sejak Microsoft Office 2003, fasilitas untuk membuatnya secara 
otomatis telah disempurnakan dan lebih mudah menggunakannya.  

Kali ini saya akan mencoba membuat daftar isi dan daftar gambar secara otomatis di 
Mirosoft Word 2007. Tidak perlu keahlian khusus atau kursus computer, kita manfaatkan 
fasilitas yang langsung tampak di hadapan kita. 

Cara membuat daftar isi otomatis sebagai berikut: 

1. Blok judul bab atau subbab yang akan dicantumkan di daftar isi. Kemudian, tentukan 
heading untuk masing-masing bab atau subbab. Urutan heading menunjukkan 
hierarki dalam daftar isi (judul bab heading 1, subbab heading 2, sub-sub bab heading 
3, dst). 

 

2. Setelah semua selesai, letakkan kursor di halaman untuk daftar isi (di dokumen yang 
sama). Kemudian, klik tab References. 

 



3. Di sebelah kiri, klik icon Table of Contents, lalu pilih (klik) bentuk daftar isi yang 
diinginkan. 

 

4. Hasilnya akan seperti gambar di bawah ini. Tulisan Table of content bisa diubah, 
misalnya: Daftar Isi. 

 

 

5. Lalu, bagaimana dengan daftar gambar? Ini pun tidak sulit. Posisi gambar (layout/text 
wrapping) harus pada posisi In line with text. Kalau belum, bisa klik kanan > Text 
wrapping > In line with text. 



 

 

6. Setelah semua gambar dalam posisi In line with text, kembali ke gambar pertama. 
Klik kanan gambar > Insert caption. 

 

 

7. Supaya labelnya menjadi gambar, klik New label. Ketik Gambar, lalu klik OK. 



 

8. Pilih label Gambar, lalu klik OK. 

 

9. Otomatis di bawah gambar akan muncul Gambar 1. Setelah muncul caption tersebut, 
ketik identitas gambar setelah angka. Hasilnya seperti gambar berikut. 

 

10. Lakukan hal yang sama untuk semua gambar. 

11. Setelah semua selesai, letakkan kursor di bawah daftar isi. Kemudian, pada tab 
References, grup Insert Caption, klik Insert Table of Figures. 



 

12. Akan ada jendela yang muncul, langsung saja klik OK. 

 

13. Hasilnya seperti gambar di bawah ini. 

 

 

Mudah bukan? Sekarang ga perlu repot lagi membuat daftar isi secara manual. 
Manfaatkan saja fitur yang ada. 

Selamat mencoba! 



Membuat File Help 

Setelah program selesai dibuat, kewajiban seorang programmer adalah membuat file help 
yang berisi informasi dan atau tata cara menggunakan program tersebut. Jika pengguna 
mengalami kesalahan atau kesulitan dalam menggunakannya, tinggal membuka file 
helpnya saja.  

Bagi programmer pemula atau yang baru belajar, mungkin agak kesulitan dalam 
membuat file ini. Sebenarnya, ada sebuah aplikasi gratis yang dapat membantu membuat 
file help. Aplikasi ini dapat didownload di sini. 

Cara menggunakannya: 

1. Buka aplikasi HelpNDoc. Setelah aplikasi terbuka, klik New Project. 

 

2. Masukkan informasi yang disediakan. 

 

3. Klik Insert a new topic. 



 

4. Ketik informasi yang dibutuhkan di kotak sebelah kanan. 

 

5. Untuk membuat sub topic, klik topic yang diinginkan lalu klik insert a new topic. 

6. Untuk membuat keyword, blok kata yang akan dibuat keyword, lalu klik kanan > 
Add as keyword. 



 

7. Setelah semua selesai, klik Tool > Compile project. 

 

8. File yang dihasilkan bisa dalam bentuk .chm atau .html. Klik Generate. 



 

9. Hasilnya seperti gambar berikut. 

 

 

 



Mempercepat Booting Windows XP 

Mempercepat booting window XP 

Anda bosan menunggu proses booting? Saat pertama kali install saja sudah terasa lama. 
Apalagi jika sudah mengnstal banyak software. Ada cara untuk mempercepat booting 
windows XP, yaitu: 

1. Buka notepad lalu keti del c:windowsprefetchntosboot-*.*/q dan simpan dengan 

nama ntosboot.bat.  

2. Tekan winkey + R, lalu ketik gpedit.msc.  

3. Buka Computer Configuration > Windows Settings > Scripts. Kemudian, klik dua 

kali Shutdown. 

 

4. Pada jendela Shutdown Properties, klik Add > Browse, lalu masukkan file 

"ntosboot.bat" dan klik Open.  

 



5. Klik OK. 

6. Tekan winkey + R, lalu ketik devmgmt.msc.  

7. Klik dua kali pada "IDE ATA/ATAPI controllers". 

 

8. Klik dua kali Primary IDE Chanel untuk membuka Properties.  

 

9. Klik tab Advanced Setting. Pada device 0 atau device 1, ubah Device Type menjadi 

None. Klik OK. 



 

10.  Klik dua kali Secondary IDE Chanel untuk membuka Properties. Lakukan hal yang 

sama seperti langkah 9. 

 



Mempercepat Windows XP 

Kalau computer cepat, kadang tidak terasa. Sebaliknya, kalau lambat, akan sangat terasa, 
bahkan sangat menjengkelkan. Banyak cara untuk menambah kecepatan system operasi. 
Salah satunya adalah dengan menonaktifkan fasilitas yang tidak diperlukan.  

Masalahnya, banyak aplikasi atau service yang berjalan secara otomatis, sehingga kita 
tidak tahu atau sulit membedakannya, mana yang penting dan mana yang tidak. 

Kita membutuhkan sebuah aplikasi untuk membantu memilih mana saja aplikasi atau 
service yang tidak kita perlukan saat menjalankan system operasi. Salah satunya adalah 
Safe XP.  

Meskipun aplikasi ini gratis, tetapi menawarkan banyak pilihan tweak untuk XP, Internet 
Explorer, dan MS Office dalam satu jendela (interface) program. Menggunakannya pun 
sangat mudah. Kalau masih bingung, klik saja tombol Recommended Setting. Secara 
otomatis akan mencentang service yang tidak perlu. 

 

Klik Apply. 

Anda bisa menceklis service lain yang menurut Anda tidak perlu. 

Mudah bukan? Silakan download di sini untuk mencobanya. 



Mengambil Gambar dari File PDF 

Banyak sumber artikel yang berbentuk pdf. Saat kita ingin menyalin ke dalam bentuk 
dokumen (word) gambar yang kita copy tidak akan bisa langsung disalin. Jika kita tidak 
memiliki software yang dapat mengubah file pdf ke word, ada alternative lain yang bisa 
dilakukan. 

Salah satu cara mengeluarkan file gambar di pdf adalah menggunakan adobe photoshop. 
Caranya sebagai berikut: 

1. Klik menu File > Open As (Alt+Shift+Ctrl+O). 

 

2. Pada kotak Open As yang terbuka, pilih Photoshop PDF (*.PDF,*.PDP) pada bagian 
Open As. Kemudian, pilih file pdf. 

 



3. Klik Open. 

4. Pada jendela import, bisa dipilih pages atau images. Kalau mau ambil gambar saja, 
klik images lalu pilih gambar yang akan dikeluarkan. Gunakan kombinasi Ctrl+klik 
untuk mengambil beberapa gambar secara acak. 

 

5. Setelah gambar keluar, simpan masing-masing gambar dalam format jpg, png, atau 
tiff. 

 

 



Mengembalikan File yang Terkena Virus 

File terkena virus pasti sangat menyebalkan. Bagi yang baru belajar computer, tentu saja 
akan membuatnya sangat panik. Sebenarnya, virus hanya menyembunyikan file asli kita, 
tidak menghapusnya. File yang ditampilkan merupakan hasil duplikasi yang dibuat oleh 
virus dengan ekstensi yang telah diubah olehnya, sedangkan file asli diubah atributnya 
menjadi file system sehingga menjadi super hidden. Meskipun diubah pada folder option 
dengan mengaktifkan show hidden file and folder, tetapi tetap saja tidak kelihatan. 

Untuk melihatnya, lakukan cara berikut: 

1. Buka window explorer. 

2. Klik menu tools > folder option. 

 

3. Klik tab View. Hilangkan ceklis Hide protected system files (Recommended). 

 

4. Dari peringatan yang muncul, klik Yes. 

 

5. Klik OK. 



6. Seluruh file dan folder yang disembunyikan virus akan terlihat samar. 

 

Kita dapat menormalkan kembali semua file dan folder yang disembunyikan oleh virus. 
Untuk mengembalikan file tersebut, caranya: 

Hapus virus dengan antivirus yang ada, misalnya: AVG. 

7. Setelah virus terhapus, buka command prompt dengan menekan tombol window+R, 
lalu ketik cmd. Kemudian ENTER. 

 

8. Masuk ke folder yang filenya terkena virus. Pada contoh ini, file berada di folder 
data, drive D. Ketika command prompt muncul, ketik D: lalu enter, kemudian ketik 
cd data lalu enter untuk masuk ke folder data. 

 

9. Ketik perintah ATTRIB *.* -s –h –r /s /d lalu enter. Keterangan masing-masing 
perintah, bis ditemukan dengan mengetik ATTRIB /? lalu enter. 



 

10. Semua file dan folder yang disembunyikan akan normal kembali dan dapat kita buka. 

 

Jadi, jangan panic jika file atau folder terkena virus. Dengan langkah yang diberikan di 
atas, file atau folder yang disembunyikan virus tetap bisa kita dapatkan kembali. 

Trik ini hanya salah satu cara untuk mengembalikan file atau folder yang terkena virus. 
Jika folder option juga dihilangkan, ada cara lain bisa kita tempuh, caranya pun tentu saja 
berbeda. 



Mengembalikan File yang Terhapus 

Selain membersihkan file sisa instalasi, glary utilities juga memiliki banyak fungsi 
lainnya. Salah satunya yang mungkin akan sangat bermanfaat adalah mengembalikan dile 
yang telah terhapus, bahkan yang sudah tidak ada di recycle bin sekalipu. 

1. Klik tab Modules lalu klik menu Privacy & Scurity. Ada empat fasilitas yang 
disediakan. Untuk mengembalikan file yang telah terhapus, klik File Undelete. 

 

2. Pilih drive tempat file yang terhapus lalu klik tombol Search. Proses pencarian akan 
berlangsung. 

 

3. Jika sudah selesai, klik file yang akan dikembalikan lalu klik Restore. 



 

4. Pilih lokasi penyimpanan, lalu klik OK. Pada dialog peringatan, klik OK. 

 



Mengunci Folder 

Punya file yang sangat pribadi? Tentu sangat riskan jika computer kita sering digunakan 
orang lain. Meskipun bisa disembunyikan (hidden), tetap saja masih bisa dibuka. 
Sebenarnya banyak aplikasi untuk mengunci file/folder, walaupun kebanyakan berbayar. 
Kali ini saya akan mencoba salah satu software pengunci file/folder dengan nama Instan 
Lock. Jika Anda ingin mencoba, silakan download di sini. 

Cara menggunakannya: 

1. Buka aplikasi Instan Lock. 

2. Masukkan password yang Anda masukkan saat pertama kali dijalankan. 

 

 

 

3. Klik OK. 

4. Klik Add untuk memasukkan folder. 

 

 

 

5. Klik folder yang akan dikunci, lalu klik OK. 

 



 

 

6. Akan keluar dialog peringatan, klik Yes. 

 

 

7. Sekarang, folder yang dikunci hilang. Folder ini tidak akan kelihatan walaupun kita 
mengaktifkan show hidden file. Bahkan, jika kita memilih menampilkan file system 
yang dihidden pun, tetap tidak akan kelihatan. 

 

 

 

8. Jika ingin menampilkannya kembali, klik folder yang akan ditampilkan, lalu klik 
Open. 



 

 

 

9. Dengan demikian, folder yang tadi dikunci, bisa dibuka kembali. Jika ingin membuka 
secara permanen, klik Remove. 

 

 

 

Kita tidak akan menyangka akan ada orang lain yang membuka file/folder pribadi kita. 
Jadi, sebaiknya gunakan software pengunci file/folder untuk mengamankannya. 

Ingat! Kejahatan terjadi bukan hanya karena niat pelakunya, tetapi juga karena ada 
kesempatan. 

Waspadalah! Waspadalah! 

 

 



Mengambil Gambar di Ms. Word 

Untuk keperluan tertentu, kadang kita perlu mengeluarkan gambar yang ada di file word. 
Cara mengeluarkannya sangat mudah. File gambar yang dihasilkan masing-masing 
terbentuk 2 buah file (biasanya dalam bentuk .png atau .jpg).  

Cara mengeluarkannya: 

1. Buka file dokumen (word), lalu save as. 

 

2. Pada bagian Save as type, pilih Web page. 

 

3. Klik Save. 

Setelah disimpan akan menghasilkan file dengan format html dan sebuah folder yang 
berisi gambar. Masing-masing gambar akan terbentuk 2 buah file (ukuran asli dan ukuran 
yang terlihat di word). 



Membawa Aplikasi ke mana pun 

Sekarang, kita bisa membawa program computer beserta bookmark, pengaturan yang 
lakukan, email, dokumen, dan lebih banyak lagi. Semuanya bisa digunakan di computer 
dengan system operasi windows versi apapun tanpa meninggalkan jejak data pribadi 
kita. 
 

 
 
 
Portableapps.com menyediakan sebuah platform yang dapat dibuka pada perangkat 
keras penyimpanan data seperti flashdisk, iPod, harddisk external, dan lain-lain. Saat 
melakukan instalasi, tempatkan lokasi penyimpanan di perangkat external (misalnya, 
flashdisk). Ke manapun flashdisk itu kita bawa, saat dihubungkan dengan computer 
berbasis windows, kita bisa membuka aplikasi yang kita install, seperti: browser internet, 
aplikasi perkantoran, pengolahan gambar, dan lain-lain. 

 
 
 

Menulis dan Mempublikasikan Blog Di Ms. Word 2007 



Banyak hal yang belum kita tahu dari apa yang kita gunakan. Salah satunya, yang paling 
sering kita gunakan adalah Microsoft Word. Pada versi yang terbaru 2007, Microsoft 
Word dapat kita gunakan salah satunya untuk membuat artikel yang dapat diposting 
langsung ke blog tanpa harus membuka blog yang bersangkutan. Tentu saja, tidak semua 
blog bisa. Ketika saya mencoba fasilitas ini, untuk wordpress dapat langsung diposting 
bersama gambar yang kita masukan, sedangkan blogger belum bisa (hanya teks saja yang 
ditampilkan). Bagi yang memiliki blog di wordpress, tentu hal ini sangat menguntungkan. 
Kita tidak perlu menyisipkan gambar di wordpress. Saat posting ke wordpress, semua 
teks yang kita ketik dan gambar yang kita sisipkan, otomatis akan tampil di blog kita. 
Untuk sementara, kita harus nunggu blogger memberikan kemampuan yang sama dengan 
wordpress. Jadi, kalau hanya ingin posting teks saja, cara ini bisa dimanfaatkan.  

Caranya sangat mudah. Setelah semua bahan kita ketik di word, ikuti langkah berikut: 

1. Klik Office Button > Publish > Blog. 

 

2. Jika belum pernah memanfaatkan fasilitas ini, akan keluar dialog register. Klik 
Register Now. 

 

3. Pilih provider blog yang diinginkan. Misalnya, WordPress. 



 

4. Klik Next. 

 

5. Masukkan alamat blog beserta username dan password. 

 

6. Klik OK. Jika sukses, aka nada informasi bahwa registrasi berhasil. Kita bisa memilih 
account ini atau menambahkan account lain dengan mengklik Manage Account di tan 
Blog Post. Klik OK. 

 

7. Ketik judul artikel. Jika ingin menambahkan kategori, klik Insert Category pada tab 
Blog Post. 



 

8. Masukkan username dan password worpress. Supaya dialog ini tidak muncul lagi, 
klik Remember Password. Klik OK. 

 

9. Pilih kategori berdasarkan artikel yang kita buat. Nama-nama kategori ini muncul jika 
kita pernah membuat kategori di wordpress. 

 

10. Setelah selesai dan yakin akan diposting, klik Publish di tab Blog Post. 

 

11. Tunggu proses posting sampai selesai. Saat proses berlangsung, akan keluar jendela 
Contacting Blog Provider. 



 

12. Jika sukses, akan ada informasi di atas artikel bahwa artikel tersebut telah di posting 
ke [nama blog] lengkap dengan waktu posting. 

 

13. Jika ingin memastikan artikel telah ada di blog atau belum, silakan buka blognya. 

 

14. Jika sukses, artikel akan tampil di blog kita, seperti gambar di atas. 

Mudah, kan? Cara ini sangat bermanfaat terutama jika koneksi internet kita menggunakan 
volume base. Dengan demikian, kita bisa menghemat pulsa, tanpa harus membuka 
browser untuk membuat artikel di blog. 

Selamat mencoba! 

 

 



Menghapus Jejak Di Komputer 

Anda pasti pernah mengalami ketika mengetik kata di kotak pencarian google ada kata 
yang keluar. Kalau masih baru menggunakan computer atau bermain internet, pasti 
bingung bagaimana cara menghilangkannya. 

Habis menggunakan computer, pasti kita meninggalkan jejak. Kalau jejaknya tidak terlalu 
penting, pasti aman-aman saja. Sangat berbahaya bila jejak yang ditinggalkan adalah hal-
hal yang sangat pribadi. Orang lain bisa membuka dan melakukan apapun dengan 
informasi yang kita tinggalkan. 

Memang, secara manual bisa diatasi. Namun, tentu saja akan memakan waktu yang agak 
lama. Untuk menghemat waktu, tentu saja perlu sebuah aplikasi untuk membersihkan 
semua jejak yang kita tinggalkan setelah menggunakan computer. 

Salah satu aplikasi yang bisa digunakan secara gratis adalah PrivacyMaster. Aplikasi ini 
mampu membersihkan jejak saat kita menggunakan windows maupun browser (internet 
explorer atau firefox).  

Cara menggunakannya: 

1. Buka PrivacyMaster yang telah diinstal. 

 

2. Jika ingin menghapus semua jejak yang ditinggalkan ketika menggunakan browser 
Firefox atau Internet Explorer, klik Select All. 



 

3. Jika ingin menghapus jejak ketika menggunakan Windows, klik tab Windows lalu 
klik Select All. 

 

4. Klik tab Erase. Di sana ada daftar jejak yang akan dihapus. Jika ingin menghapus 
semua jejak, klik Erase. 

 



Mudah bukan? Kita tidak perlu secara manual menghapus semua jejak aktivitas yang kita 
lakukan. Jika ada orang lain menggunakan computer setelah kita, dia tidak akan tahu apa 
saja yang kita lakukan. 

Jika ingin mencoba aplikasi ini, silakan download di sini. 



Membuat File PDF dengan PDF Creator 

Ada satu lagi software gratis untuk membuat dokumen dalam bentuk pdf. Software ini 
sangat mudah digunakan. Setelah saya coba, bisa membuat pdf dengan file sumber 
document word, excel, txt, rtf, html, dan lain-lain. Artikel ini juga ditulis sebagai 
alternative dari artikel sebelumnya. Software ini bisa digunakan untuk semua versi 
Microsoft Office. 

 

Cara menggunakannya sangat mudah: 

1. Drag and drop file dokumen yang akan Anda buat pdf, lalu tunggu proses yang 
disebut “Wait-Collect”.  

 

2. Klik Save, lalu simpan di lokasi yang Anda inginkan. 



 

3. Klik Save dan tunggu proses convert ke pdf selesai. 

Hasilnya seperti gambar berikut. 

 

4. Jika ingin menandai (member cap) file pdf Anda, klik toolbar Options. 

 

5. Klik Document, lalu ketik sebuah kata pada Stampstring. 



 

Setiap Anda membuat file pdf, setiap halaman akan dicap sesuai kata yang Anda ketik. 

 


